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1 Preliminary note
1.1 Symbols used

► Instruction
> Reaction, result
[…] Designation of pushbuttons, buttons or indications
→ Cross-reference

Important note 
Non-compliance can result in malfunctions or interference.
Information 
Supplementary note

2 Safety instructions
Please read the operating instructions prior to set-up of the device. Ensure that the device is suitable for 
your application without any restrictions. 

If the operating instructions or the technical data are not adhered to, personal injury and/or damage to 
property can occur.

3 System requirements
3.1 Hardware

PC with Pentium III processor or higher, clock frequency min. 500 MHz––
min. 128 MB RAM––
min. 35 MB freely available hard disk memory––
CD-ROM drive––
XGA compatible graphic card with min. 1024 x 768 pixel resolution––
Ethernet network card for 10Base-T/100Base-TX, TCP/IP protocol––
PC mouse––

3.2 Software
Microsoft XP or Vista operating system––

3.3 Required accessories 
Crossover cable for parameter setting connection (Ethernet), M12 connector/RJ45 connector, 4 ––
poles 
e.g. article no.: E11898 (2 m)
Connection cable for supply voltage and process connection, M12 socket, 8 poles ––
e.g. art. no. E11231 (2 m, wirable cable end) 

You can find more information about the available accessories (here e.g. for O3D200): 
www.ifm.com  → Data sheet direct → O3D200→ Accessories

4 Functions and features
In conjunction with efector pmd3d the PC operating program E3D200 provides the following: 

measurement and evaluation of volume, level or distance●●
creation, administration and deletion of application-specific applications●●
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5 Installation
Installation and setting for operation with a fixed assigned IP address are described below (= direct 
connection to the PC). 
This is the factory-preset operating mode of the sensor.

The figures and texts show the installation process under Windows XP. In other Windows versions 
installation is carried out in the same way.

5.1 Hardware
Connect the device to the Ethernet interface of the PC using a crossover cable.►►

5.2 Software
To start the PC user program you have the following options:

start directly from the CD●●

copy to the PC and direct start●●

installation on the PC●●

5.2.1 Start the program from CD without installation
Insert the CD in the drive.►►
The start menu opens.>>

Select menu item "Start efector pmd3d".►►
The program starts.>>

If the autostart function for CD drives is deactivated and the start menu does not open 
automatically:

Start the "O3Dstart.exe" file  in the main directory of the CD with a double click.►►
The start menu opens.>>

Select menu item "Start efector pmd3d".►►
The program starts.>>

5.2.2 Start the program from the hard disk without installation
Copy the PC user program from the CD to the hard disk.►►
Start the "O3Dstart.exe" file in the main directory with a double click.►►
The start menu opens.>>

Select menu item "Start efector pmd3d".►►
The program starts.>>

5.2.3 Install program on the hard disk
Insert the CD in the drive.►►
The start menu opens.>>

Select menu item "Install efector pmd3d" and then follow the instructions of the installation routine.►►
The program is installed.>>

If the autostart function for CD drives is deactivated and the start menu does not open 
automatically:

Start the "O3Dstart.exe" file  in the main directory of the CD with a double click.►►
The start menu opens.>>

Select menu item "Install efector pmd3d" and then follow the instructions of the installation ►►
routine.
The program is installed.>>
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5.3 Factory setting

5.3.1 Network setting IP address range
The IP address range of the device and the PC have to match.

Network address Station address

efector pmd3d O3D2xx 192.168.0 69

= ≠

PC 192.168.0 e.g. 10 

5.3.2 Factory setting parameters

efector pmd3d O3D2xx 
Parameters

Description Factory setting

DHCP Dynamic Host Configuration Protocol off

IP IP address 192.168.0.69

nETm Subnet mask 255.255.255.0

GWIP Gateway address 192.168.0.201

5.3.3 Verify and set the IP address of the PC

Changes in the network settings of the PC require extended user rights. 
Contact your system administrator.

Activate the menu "Internet protocol (TCP/IP) Properties". ►►
The Windows menu "Internet protocol (TCP/IP) Properties" is accessible for example via: Start → 
Control Panel → Network Connections → Local Area Connection → Properties.

Select the option "Use the following IP address".►►

Verify and, if necessary, set the IP address (here e.g. 192.168.0.10).►►

Enter the subnet mask (255.255.255.0).►►

Leave default gateway blank.►►

Confirm the settings with [OK].►►
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6 Basic functions of the program
6.1 Basics of operation

6.1.1 User interface

3

2

B

5

C

A
4

1

7

6

Pos. Operating elements Function

1 Mode Applications ●●
Create, edit, delete etc. applications
Monitor ●●
Display or visualisation
of the detected object––
of the set parameter values––
of the result window––

2 Status bar Network status of the device (OFFLINE/ONLINE)●●
Device name●●
Article number/production status of the device/firmware of the connected device●●
Visualised display of the sensor temperature●●
Evaluation time●●

3 Tool bar Buttons (e.g. "Save" or "Connect")  
Commands that cannot be selected are displayed in grey.

4 Menu bar Pulldown menus with program functions.

5 Button [About this page...] Information about the currently selected mode or the currently selected applica-●●
tion

6 Result window Selected sensor program (distance, volume or level)●●
Result (e.g. 230 mm) ●●

7 Tabs Tabs for the configuration of the parameters
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Pos. Operating elements Function

A/B/C Ways of selection Identical commands can be selected in different ways: 
(depending on the program function)
A	 = selection via pulldown menu in the menu bar 
B	 = selection via button 
C 	 = selection via context menu (click with right mouse button)

6.1.2 Keyboard functions
The following keyboard functions are provided in the parameter setting module "Program":

Key combination Contents

[Shift] + [Tab] Select  image zone or cancel selection.●●
If several image zones are defined, the selection will change from one image zone ●●
to the next.

[Shift] + [Ins] Duplicate selected image zone.●●

[Shift] + [Del] Delete selected image zone.●●

[Shift] + Arrow key Move the selected image zone by one pixel in the respective direction.●●

6.2 Program start
Start the PC operating program.►►

The start screen displays the article number, program designation and version number for approx. 5 s.>>

When the program is started for the first time and the device is as supplied, the neutral user interface >>
will be displayed. 
(On delivery an application with default settings is stored.)
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Status: OFFLINE 

6.3. Select user language
Select the desired language in the menu bar with [Settings] [Language] → [English].►►

6.4 Connect device to the operating program

6.4.1 Alternative 1: Bookmark entry
Select [Connections] → [IP address] in the menu bar.►►
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User interface changes to the connection settings.>>

“Saved bookmarks" contains a bookmark entry with the default settings of the device. >>
(If this is not the case, continue with 6.4.2 or 6.4.3).

Mark the bookmark entry (e.g. "New sensor") and click on [Connect]. ►►
As an alternative: Double-click on the entry.

Change of status: OFFLINE → ONLINE >>

The user interface changes to the monitor mode. ––
The [Monitor] button is activated. 
After a trigger pulse the monitor window displays the current capture of the device. 
The result field on the right displays the current results.
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Establishing the connection may take several seconds.

6.4.2 Alternative 2: Enter the IP address of the device
Select [Connections] → [IP address] in the menu bar.►►

User interface changes to the connection settings.>>

Enter the IP address of the device in the field "IP address".►►

Assign preset port number 8080.►►

If a firewall is active on the PC, ensure that this port and the port number 50002 have been 
enabled for image transmission.

Click on [Connect].►►

Change of status: OFFLINE → ONLINE >>
(like 6.4.1)
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6.4.3 Alternative 3: Find IP address of the device
Select [Connections] → [IP address] in the menu bar. ►

User interface changes to the connection settings . >

Click on [Find sensors…] . ►

The window "Network search" opens . >

Under "Scan zones" the IP zone set on the PC is automatically assigned (here e .g .192 .168 .0 .0) . >

If you want to search other networks, you have to ensure that the gateways of your PC are 
correctly set . In case of doubt, contact your network administrator . 

If you want to search other networks, overwrite the IP address range in the field "Network address" . ►

Click on [Add] . ►

The network address is added to the search list . >
The fields for the network address and subnet mask are blank so that other entries can be made in the 
search list .
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Click on [Start scanning].►►

The devices found are listed in the "Detection of the sensors" box.>>

Click on [Assign].►►

All network data necessary for the connection to the device is saved locally on the PC in a bookmark >>
entry with the indicated device name and its location.

Mark entry in the search list and click on [Connect]. ►►
As an alternative: Double-click on the entry in the search list.

Change of status: OFFLINE → ONLINE >>
(like 6.4.1)
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7 Operating modes
The device distinguishes two operating modes

Monitor●●

Applications●●

7.1 Monitor

When you have switched on the unit you are in the monitor mode. Here you can watch the sensor 
working.

1
2 3

4
5

Pos. Element Function

1 Visualisation Alternatives for visualising the sensor image.

2 Tab [Parameters] Exposure time●●
Dynamics●●
Background●●
Trigger mode●●
Idle time●●

3 Tab [Extended information] Switch and start points●●
Status of the filter●●
Setting of result averaging●●
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Pos. Element Function

4 Sensor image Visualisation of the current sensor image depending on the 
setting of the visualisation

5 Result window Currently set program●●
Results●●
Outputs●●

7.1.1 Intensity image

The intensity image describes the visualisation on the basis of the reflectivity of the object to be displayed. 
It can be compared with a black and white photo of a camera.

This mode is suitable for the following activities:

setting the focus of the lens (by means of the setting screw on the back of the unit) ●●

adjusting the position of the active image section.●●

The active image zone is visualised by a red frame.

Colour indicators
Blue-shaded image zones: ●●
Pixels outside the defined active image zone. 

Red-shaded image zones: ●●
Pixels with too weak a light reflection are visualised in red.

Orange-shaded image zones: ●●
Pixels with too intense a reflection are visualised in orange (too little distance to the object).

Red, orange and blue image zones will not be included in image calculations.

Red and orange image zones should be avoided. Corrections are possible when the image quality is 
adjusted.

For visualisation the individual pixels are standardised across the entire image zone. Pixels of high 
intensity are displayed as light, pixels of low intensity are displayed as dark. 
If the dynamics of the sensor image is very high, i.e. the difference between the "strongest" and the 
"weakest" pixels is significant, the zones of little reflection are displayed as very dark, contours at a larger 
distance can often no longer be recognised. 
In that case the band width of intensities can be displayed as a logarithm which is almost like a reduction 
in contrast.

Select [Linear] or [Logarithmic] display.►►
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7.1.2 Distance image

The distance image describes the object scenario on the basis of the distance to the sensor. In this 
process each pixel is assigned a corresponding colour from the spectrum depending on the distance to 
the sensor. Short distances start in the red range and within the spectrum change to shades of blue for 
larger distances via the yellow and green ranges.

Display
When the [Auto] button is activated, the entire range of the distance values is displayed in an optimum 
way on the colour spectrum available. The assignment of the distances to the colours is shown on the left 
of the bar graph.

Normalisation is carried out on the basis of the first distance values to be visualised and is kept. If the 
distance values are significantly changed in the course of image visualisation, for example due to major 
changes in the scenario, normalisation is adapted automatically.

When the [Manual] button is activated, you can change the distribution of the colour spectrum. In the 
input fields you set the minimum and the maximum distance values in whose range the colour spectrum 
is to be redistributed. The "Background" field stands for the maximum distance value, "Object" for the 
minimum distance value. 

Adapt colour spectrum manually
Click on [Manual].►►

The background and object fields are enabled.>>

To determine the current distance of a special pixel, click on the requested pixel with the right mouse ►►
button.

The measured distance value is displayed below the sensor image.>>

Enter requested values between 0 and 6500 mm for "Background" and "Object" .►►

The input value for "Background" must be greater than the value for "Object".

Click on [Assign].►►
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7.1.3 Perspective view

In principle the perspective view corresponds to the distance image view. There is, however, spatial 
visualisation. In this process each pixel is assigned a corresponding colour from the spectrum depending 
on the distance to the sensor. 
Short distances start in the red range and within the spectrum change to shades of blue for larger 
distances. 
Invalid pixels are shown in white. They are either at a distance of more than 6.5 m from the device or they 
are not included due to their high degree of reflection.

Types of display
Select the types of display of the perspective view in the tool bar►►

Symbol Function

Displays the distance data of the sensor as individual coloured pixels.

Displays the distance data of the sensor as a coloured bar.

Displays the distance data of the sensor as a coloured mesh network.

Displays the distance data of the sensor as a coloured perspective model.

Shows/hides the coordination grid.

Enlarges the perspective view.

Reduces the perspective view (standard setting).

Display
When the [Auto] setting is enabled, the entire range of the distance values is displayed in an optimum 
way on the colour spectrum available. The assignment of the distances to the colours is shown in the bar 
graph on the left.

Normalisation is carried out on the basis of the first distance values to be visualised and is kept. If the 
distance values are significantly changed in the course of image visualisation, for example due to major 
changes in the scenario, normalisation is adapted automatically.
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When the [Manual] button is activated, you can change the distribution of the colour spectrum.  In the 
input fields you set the minimum and the maximum distance values in whose range the colour spectrum 
is to be redistributed. The "Background" field stands for the maximum distance value, "Object" for the 
minimum distance value.

Using the [Options] button you can show or hide the option field for image adjustment. If the options are 
suppressed, you will see the result window.

Adapt colour spectrum manually
Click on [Manual].►►

The “Background” and “Object” input fields are enabled.>>

Enter values between 0 and 6500 mm for “Background” and “Object”.►►

The input value for "Background" must be greater than the value for "Object".

Click on [Assign].►►

Change the viewing position
You can change the position interactively.

Left-click into the field of view and move the mouse, keeping the mouse button pressed, into the ►►
required direction of rotation.

The object moves around its centre of gravity into the required viewing position.>>

Restore the initial perspective
Click on [Default view].►►
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7.1.4 Segmentation

The segmentation shows what the sensor interprets to be the background and what to be the object. The 
object is shown in white, the background in black. Noise of the pixels (white pixels in the background 
or black pixels in the object as shown in the screenshot) should be avoided. Noise can be avoided by a 
respective setting of the image quality.

7.1.5 Save data
The current evaluation image and the current image data can be stored as follows:

Symbol Function

Saves the current evaluation image as a bitmap file (*.bmp)
Indicate the file name and the memory location in the newly opened window.►►

Saves the current image data (intensity, distance or segmentation values) in table format (*.csv) 
Image data of the perspective view cannot be saved.
The values are structured by lines, the individual values are separated by a semicolon so that the data can be 
imported in standard spreadsheet programs.

Indicate the file name and the memory location in the newly opened window.►►
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7.2. Applications
The device can save up to 32 applications (= parameter sets). 
When creating an application, the following parameters have to be taken into account:

Program1.	
Image quality 2.	
Image zone3.	
IO configuration4.	

7.2.1 Activate application mode
Click on [Applications].►►

1 2

3 4 5

Pos. Element Function

1 Administer applications New, Activate, Edit, Rename, etc.

2 Application directory Overview, structure and selection of the applications.

3 General General administration (device-specific names, info about soft-
ware version etc.).

4 Global sensor settings Possible basic settings of the performance and network parame-
ters of the device.
Trigger input debouncing (on/off)
External selection of the application (on/off)

5 Network parameters Network parameters (DHCP on/off, IP address etc.)
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7.2.2 Change sensor name and sensor location

Enter sensor name and sensor location according to the application. ►►

Transfer the entries to the device with [Assign].►►

Field Function

Sensor name Any application-specific device name

Sensor location Location description (e.g. shelf 3)

Firmware version Firmware version of the device (cannot be edited and can only be changed via update)
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7.2.3 Configure global sensor settings
Open the [Global sensor settings] tab.►►

Verify and, if necessary, change all entries.►►

Element Function

Trigger input debouncing Prevents that several pulses occurring shortly after each other cause a trigger process on 
the unit (mechanical trigger switch). 
With "On" a stable pulse has to be on the input for at least 3 ms so that it is recognised as a 
trigger pulse. Shorter pulses are ignored.

External selection of the 
application

If this option is activated, pins 7 and 8 of the process interface are used as inputs which can 
externally switch the first four applications. 
Pin 7 is the least significant bit (LSB), pin 8 is the most significant bit (MSB)
Possible switching operations: 
Pin 7: 0, pin 8: 0 -> application on memory location 1 active
Pin 7: 1, pin 8: 0 -> application on memory location 2 active
Pin 7: 0, pin 8: 1 -> application on memory location 3 active
Pin 7: 1, pin 8: 1 -> application on memory location 4 active
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7.2.4 Define network parameters
Open the [Network parameters] tab.►►

Verify and, if necessary, change all entries.►►

Transfer the entries to the device with [Assign].►►

Field Function

DHCP mode In the DHCP mode the fields for IP address,  subnet mask and gateway are blocked. The 
sensor is assigned an address by the DHCP server.

IP address Currently assigned IP address of the device

Subnet mask Standard setting subnet mask

Gateway Default gateway address

XML-RPC port The port number for the communication via the XML-RPC protocol 
(Remote Procedure Call)

Video port Port number for the transmission of images

MAC address The MAC address of the device (cannot be changed)
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7.2.5 Create new application
Click on [New] . ►

Assign an index number . Range: ►

figure between 0 and 32 –

Enter the name of the new application . Required information: ►

Length of the name 1...32 characters –
Umlauts allowed (Ä, ä,  . . . )
No blank or tabulator characters before and after an entry
No special characters  (&, $, -  . . .)

Acknowledge with [OK] . ►

The new application is created . >
The user interface changes to the first application step "Program" (→ Chapter 8.1). >
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7.2.6 Activate existing application

Mark the name/number of the application in the directory structure . ►

Click on [Activate] . ►
As an alternative: selection via the context menu (right mouse button)

The colour of the activated folder changes from blue to green . >

7.2.7 Edit existing application
Mark the name/number of the application in the directory structure . ►

Click on [Edit] . ►
As an alternative: selection via the context menu (right mouse button)

The user interface changes to the first application step "Program" (→ Chapter 8).  >
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7.2.8 Rename an existing application
Mark the name/number of the application in the directory structure.►►

Click on [Rename]. ►►
As an alternative: selection via the context menu (right mouse button)

Enter the new name in the new window "Rename application".►►

Acknowledge with [OK].►►

7.2.9 Delete an existing application
Mark the name/number of the application in the directory structure.►►

Click on [Delete]. ►►
As an alternative: selection via the context menu (right mouse button)

Acknowledge the confirmation prompt in the new window with [Yes].►►

The application is deleted.>>

7.2.10 Upload from device
You can save the sensor settings on your PC and transfer them to another device using the [Download to 
device] function.

Mark the name/number of the application in the directory structure.►►

Click on [Upload from device]. ►►
As an alternative: selection via the context menu (right mouse button) or via the tool bar → 

Define the memory location on the hard disk and assign a file name.►►

Acknowledge with [Save].►►
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7.2.11 Download to device
You can transfer data saved on the PC to the sensor.

Mark the name/number of the application in the directory structure.►►

Click on [Download to device]. ►►
As an alternative: selection via the context menu (right mouse button) or via the tool bar → .
Select the file on the hard disk and click on [Open].►►

Assign an index number. Range:►►

figure between 0 and 32––

Enter the name of the new application. Required information:►►

Length of the name 1...32 characters ––
Umlauts allowed (Ä, ä, ... ) 
No blank or tabulator characters before and after an entry 
No special characters  (&, $, - ...)

The application is downloaded to the device and can be seen in the directory structure.>>

7.2.12 Help
Opens the by-topic online help.
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8 Create applications and set parameters
When a new application has been created or an existing one has been edited, the user interface changes 
to the first application step "Program".

8.1 Navigation
There are two possibilities to navigate through the process of parameter setting:

using the buttons (navigation) [ Back], [Cancel] and [Next]●●

using the button (module)●●

8.2 Select the sensor program
In the parameter setting module "Program" you determine the measurement task and the unit of 
measurement.
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8.2.1 Program
You define the measurement task in the [Program] tab.

Entry Function

Volume Determines the volume of an object on the basis of the surface structure and the distance to the back-
ground (unit of measurement: litre).

Minimum distance Determines the distance between an object and the sensor (unit of measurement mm or inch).
The smallest distance value each of the image zone set is used.

Maximum distance Determines the distance between an object and the sensor (unit of measurement mm or inch).
The greatest distance value each of the image zone set is used.

Average distance Determines the distance between an object and the sensor (unit of measurement mm or inch).
The distance values on which the measurement is based are averaged across the entire set image 
zone.

Minimum level Determines the distance between the object and the background on the basis of the distance value 
across the entire surface of the object This corresponds to the level (unit of measurement mm or 
inch).
The smallest distance value each of the image zone set is used.

Maximum level Determines the distance between the object and the background on the basis of the distance value 
across the entire surface of the object This corresponds to the level (unit of measurement mm or 
inch).
The greatest distance value each of the image zone set is used.

Average level Determines the distance between the object and the background on the basis of the distance value 
across the entire surface of the object This corresponds to the level (unit of measurement mm or 
inch).
The distance values on which the measurement is based are averaged across the entire set image 
zone.
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8.3 Image quality
In this module you set the parameters for optimum image capture.

Optimise the image definition via the setting screw on the back of the device. ►►

Due to the low resolution and the different distances in a scenario manual setting has only little 
influence on the result of the measurement.

8.3.1 Parameters
You define the characteristics of image capture in the [Parameters] tab.

Exposure time
The exposure time means the time it takes to capture the sensor image. You can have the exposure time 
set automatically or you can set it manually. In the following cases it is necessary to change the exposure 
time:

Image quality Setting

Many white image zones (overexposure) Reduce exposure time

Many black image zones (underexposure) Increase exposure time
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Image quality Setting

White and black image zones (high dynamics due to 
high-contrast image)

Set dynamics to [High]●●
Increase exposure time●●

Considerable noise or flickering of the image Increase exposure time●●

Dynamics
For high contrast images, light objects reflect too much light, dark objects, however, too little light. In the 
"Dynamics" field you can compensate this contrast. The following settings are recommended: 

Image quality Setting

No white and black image zones simultaneously (low 
dynamics due to low contrasts)

[Normal]

White and black image zones (high dynamics due to 
high-contrast image)

[High]

With the setting [High] the sensor works with double exposure. It measures with a short and then a second 
long exposure time. During the short exposure time it fills up extremely overexposed zones. 
Double exposure prolongs the total exposure time which may cause blurred edges for moving objects.

Background

Image quality Setting

Scene has a defined background. [Bordered]

Scene does not have a defined background.
The sensor detects objects at a distance greater than 6 m.

[Open-ended ]

If the sensor detects objects at a distance longer than 6 m, it only provides meaningful results with the 
setting [Open-ended] activated. With this setting the measuring range of the sensor is set to longer 
distances. The exposure time, however, is doubled which may cause blurred edges with moving objects.

Parameter setting
To determine the optimum parameters take the following steps:

Open the [Parameters] tab.►►

Click on [Normal] in the "Dynamics" field.►►

The overexposed areas are identified by the white pixels. In these areas too much light is reflected.>>

Click on [Auto setting].►►
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The exposure time is calculated and the slider bar in the "Exposure time" field is set automatically. >>
 
As an alternative: Set the exposure time manually by means of the slider bar.

Reduce the exposure time if there are overexposed areas (white pixels).––

Increase the exposure time if there are underexposed areas (black pixels).––

If the image shows overexposed and underexposed areas (white and black pixels), click [High] in the ►►
"Dynamics" field.

If there are white pixels, noise or flickering of the image, optimise the exposure time.►►

White pixels: reduce exposure time.––

Noise or flickering: increase exposure time.––

8.3.2 Filters
Select the suitable filter for smoothing noisy data in the [Filters] tab. During filtering the information of 
neighbouring pixels is used to change the value of the central pixel. Filtering results in smoothing of the 
surfaces and rounding of the edges. The more a surface is smoothed, the more an edge is rounded.

Filters influence the exposure time only insignificantly. Differnet filters can be combined.

Filters help improve poor data; however they remain poor data. Therefore optimisation should first 
of all be effected by exposure.

With the spatial filters median and mean, "3x3 averaging" is used.  
First of all the measured value of a pixel to be filtered is considered. Then it is put into relation with the 8 
adjoining pixels. Each filter calculates a mean value from the 9 pixels, the calculation conditions for the 
various filters vary.

Median filter

This filter has excellent smoothing characteristics and influences the edges insignificantly (standard 
setting). It excludes the 4 extreme values from the 9 pixels (2 positive and 2 negative outliners) and 
calculates the mean value of the other pixels.
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Mean filter

This filter has excellent smoothing characteristics and generates very blurry edges. The mean value is 
calculated from the algebraic averaging of the 9 pixels: They are added and divided by 9. 

Result averaging 

Determines the number of images used for calculating an output value. The default setting is 1 image, i.e. 
the output of the result is calculated on the basis of each individual image. 

The number of images can be increased for time-uncritical applications, e.g. for level detection. This 
leads to more precise results; at the same time, however, it also increases the evaluation time (output 
frequency). Result averaging means smoothing the results with regard to time.

Calculation of the output frequency: Output frequency = sampling rate / number of images result 
averaging.

Select filter
Open [Filters] tab.►►

Select or deselect requested filter.►►

If necessary, increase the number of images in the "Result averaging" field.►►

Acknowledge with [Assign].►►

8.3 3 Trigger
Select the trigger mode and the idle time in the [Trigger] tab.

Trigger mode
The trigger mode describes the trigger source. The following sources are available:

Entry Function

Positive edge External triggering with positive edge

Negative edge External triggering with negative edge

Continuous Internal triggering

Idle time
The idle time influences the sampling rate. The sampling rate corresponds to the number of images 
captured per second in continuous, internally triggered operation.

8.3.4 Restore the factory setting
Click on [Factory setting]. ►►

The parameter values are reset to>>

Exposure time 10.1 ms––

Sampling rate: 4 Hz––

Result averaging via: 1––
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8.3.5 Test trigger
Using the [Release trigger] button you can test the trigger.

Select the trigger mode in the "Trigger mode "field.►►

external triggering (positive edge)––
external triggering (negative edge)––
internal triggering (continuous)––

Click on [Release trigger].►►

After triggering the captured image and the test results are displayed in the result window.>>

8.4 Image zone
In this module you select the image zone and set the application-specific parameters.
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8.4.1 Select one or several image zones
In the monitor field you can select one image zone (ROI = region of interest) or several image zones 
(multi ROI) that are to be evaluated individually by the sensor.

Selection is effected by dragging a selection frame and by the requested image zones. The monitor field 
can be divided into up to 64 selection frames. Overlapping of individual selection frames is possible.

As default setting a selection frame is already created in the monitor field which you can drag open and 
move using the mouse pointer.

One or several new selection frames can be created by taking the following steps:

Open the [Image zone] tab.►►

Click on [New].►►

To move the selection frame, take the following steps:►►

Move the mouse button into the centre of the selection frame until it changes to take the shape of a ––
cross.

Press the mouse button and move the selection frame keeping the mouse button pressed.––

To drag the selection frame open, click on the requested edge using the mouse pointer and drag the ►►
selection frame open around the requested object (ROI = region of interest). 
 
As an alternative: Selection via the context menu (right mouse button), tool bar →  or keyboard 
function.
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8.4.2 Duplicate image zone
Open the [Image zone] tab.►►

Click into the centre of the selection frame to select it.►►

The selection frame has a red frame.>>

>>  The selection frame is duplicated and selected.

8.4.3 Delete selection frame
Open the [Image zone] tab.►►

Click into the centre of the selection frame to select it.►►

The selection frame has a red frame.>>

Click on [Delete]. ►►
 
As an alternative: Selection via the context menu (right mouse button), tool bar→  or keyboard 
function.

The selection frame is deleted.>>

8.4.4 Teach sensor
In the [Parameters] tab you define the environment scenario (background, object height, reference 
object).

The requested parameters vary depending on the selected program (volume, distance or level).

In principle you have 2 options for defining the parameters:

Enter values manually into the fields●●

Have the values measured automatically by the sensor●●
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Enter the values manually
Enter the value into the requested field►►

Click on [Assign]►►

Teach values
Click on [Teach] next to the requested field.►►

One ROI (as a standard always the first or the selected one) can be taught as a reference object for all 
ROIs.

If you have selected several image zones, the result window will display the extreme values irrespective 
of the set program. The minimum and the maximum measured values are determined across all image 
zones.

If you select the individual image zones, the selected image zone ("Sel. ROI") is displayed in addition to 
the measured value.

Teach process for the "Distance" program
Depending on the preselection either the minimum, maximum or average distance is determined.

For the definition of the switch points (IO configuration) at a later point of time there is the option to define 
the distance value as a percentage value of a reference object. To do so, the distance to a reference 
object has to be entered or taught.

To define the distance to a reference object, take the following steps:►►

Position the reference object in the field of view.––

Click on [Teach].––

The value taught is displayed in the "Reference object" field. >>
 
As an alternative: 

Enter a distance value in the "Reference object" field.––

Click on [Assign].––
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Teach process for the "Volume" program
For the definition of the switch points (IO configuration) at a later point of time there is the option to define 
the volume value as a percentage value of a reference object. To do so, the volume of a reference object 
has to be entered or taught.

Remove all objects to be detected from the field of view.►►

Only the background area is displayed.>>

Click on [Teach] next to the "Background" field.►►

The distance between the sensor and the background area is determined.>>

The taught value is displayed as the reference value REF in the "Background" field.   >>

0 l is displayed in the result window. >>
 
As an alternative: Enter the requested distance value in the field and assign it.  
This ensures that for example vibrations of a conveyor can be suppressed.

Position the object(s) in the image zone.►►

If necessary, define the ROI.►►

To define the volume of a reference object, take the following steps:►►

Position the reference object in the field of view.––

Click on [Teach] next to the "Reference object" field.––

The taught value is displayed in the "Reference object" field. >>
 
As an alternative: 

Enter a volume value in the "Reference object" field.––

Click on [Assign].––

Click on [Segmentation] under "Visualisation".►►

Ideally the object is displayed in white and the background in black.>>
If there are black pixels on the object, take the following steps:►►

Enter a minimum height in the "Min. object height" field starting from which an object stands out ––
from the background.

Click on [Assign].––

The output screen indicates the real volume value in litres.>>

Teach process for the "Level" program
Depending on the preselection either the minimum, maximum or average level is determined.

For the definition of the switch points (IO configuration) at a later point of time there is the option to define 
the level as a percentage value of the max. level. To do so, the maximum level has to be entered or 
taught.

Empty the tank (if possible).►►

Position the object(s) in the image zone.►►
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If necessary, define the ROI.►►

Click on [Teach] for "Distance to reference level".►►

The distance between the sensor and the tank floor is determined. >>

The taught value is displayed as the reference value REF in the "Distance to reference level" field. >>
As an alternative: Enter the distance between the sensor and the tank floor in the "Distance to 
reference level" field and assign it.

To define the maximum level, take the following steps:►►

Fill the tank up to its maximum.––

Click [Teach] for the "Max. filling level" field.––

The taught value is displayed in the "Max. filling level" field. >>
 
As an alternative: 

Enter the maximum level in the "Max. filling level" field.––

Click on [Assign].––

If there are black pixels on the object, take the following steps:►►

Enter a minimum height in the "Min. object height" field starting from which an object stands out ––
from the background.

Click on [Assign].––

The output screen indicates the real level in mm or inch.>>
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8.5. IO configuration
In this module you define the output logic and the switch points of the outputs. All ROIs are monitored for 
the same switch points.

8.5.1 Terms
Abbreviation Term Button (icon)

HNO Hysteresis function, normally open

HNC Hysteresis function, normally closed

FNO Window function, normally open

FNC Window function, normally closed
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8.5.2 Hysteresis function
The hysteresis keeps the switching state of the output stable if the process value fluctuates around the 
set point. When an object approaches, the output switches when the set point is reached. When the 
object is removed again, the output does not switch back before the value is below the reset point. 

8.5.3 Window function
The window function enables the monitoring of a defined acceptable range. If the process value is 
between the set point and the reset point, the output is closed (window function, normally open) or open 
(window function, normally closed). The window functions also work with switching hysteresis.

Set and reset points are fixed and symmetrically arranged around the selected switch point. The 
hysteresis is the distance between the set and reset points.
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8.5.4 Current output / voltage output
These two functions provide an analogue signal on the output which increases or decreases linearly 
depending on the size of the process value.

With the parameters "Analogue start point" and "Analogue end point" you define at which process value the 
minimum or maximum is reached.
Depending on the requested configuration a rising or falling edge can be implemented.

Function Button (icon)

Rising edge (voltage)

Falling edge (voltage)

Rising edge (current)

Falling edge (current)

8.5.5 Configure the outputs
Output 1 can be configured as an analogue or digital output, output 2 only as a digital output.

In the tabs you can select if the minimum or maximum measured value of all ROIs is to be used in the 
"Multi-area processing logic" field (corresponds to the "Min." or "Max." values). This enables more precise 
monitoring of overfill or underfill. The field is only active, if more than 1 ROI has been created.

Click on the requested logic function under "Output 1" and "Output 2".►►

Select the respective [Output 1] or [Output 2] tab.►►

Select between the absolute value and indication in percent using the button ►► .

To ensure reliable hysteresis both switch points have to be above the requested value.

Enter values for the switch points.►►

Select the respective entry in the "Multi-area processing logic" field.►►

Click on [Assign].►►
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9 Update sensor software
The update consists of a file with the extension *.swu. 

During the update all data stored on the sensor will get lost.

Possibly store the data saved on the sensor.►►

Save the update file (file extension: *.swu) in a directory of your choice.►►

Connect to the requested sensor.►►

Change to the [Applications] mode.►►

Select [File] → [Update sensor firmware] in the menu bar.

If the data saved on the sensor have been stored, acknowledge warning with [Yes].►►

The user interface changes.>>

Select SWU file for the sensor update. ►►

File is transmitted to the sensor. >>

This process will take a while. After successful transmission you receive a message. Then the sensor 
automatically makes a reset. After initialisation you can connect to the sensor as usual.

When the firmware is updated, the IP address is reset to the factory setting.

Do not interrupt the current supply to the sensor during the update process! This results in loss of 
data and functionality of the sensor.
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10 Exit the program
10.1 Disconnect

Select [Connections] → [Disconnect] in the menu bar.►►

As an alternative: Click on the disconnect symbol in the tool bar. → ►► .

Acknowledge query with [OK].►►

The device is disconnected from the program.>>

10.2 Close the program
Select [File] → [Exit] in the menu bar.►►
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